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1 CSI 6500 硬件 

1.1 CSI 6500 框架介绍 

1.1.1 描述 

CSI 6500 在线监测仪可以配置为符合 API670 标准的保护系统以及提供瞬态

监测、分析的高级预测分析系统。 

 

 

CSI 6500 主要包括以下 2 部分： 

 处理器卡， A6560/A6560-T 

 信号卡， A6510/A6510-T 

1.1.2 A6560 处理器卡 

设备状态中央处理器提供设备现场基本信息和智能型预测分析，是

CSI6500 设备状态监测 的核心部分。 

A6560 可以实现以下功能： 

 A6560 包括一个是时候的振动总量处理器。 

 A6560 包括一个可组态，基于事件，自适性设备状态处理器。 

 阶次跟踪 
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 PeakVue 选项 

 Modbus TCP/Ethernet 输出选项 

 本地系统状态检测和状态 LED 显示。 

 板载内存可以在网络丢失时存储设备状态数据。 

 每个 A6560 最多支持两块 A6510 模块。 

一般参数   

存储容量 32MB SDCRAM，32M 闪存 

网络通讯 10/100BaseT 以太网 NIC 和 HUB，前后 RJ45 插口 

HUB 能够使用雏菊型网络体系结构 

本地通讯 HUB 及 RS232 串口 

本地显示 振动总量 

  机箱内部温度 

板卡自检 所有信号通道和转速通道的交流、直流幅值和相位 

CSI4500 机箱继电器 断电或重启时继电器将改变状态 

  SPDT 24VDC@0.5A DC 干接触 

总体振动监测   

信号通道扫描： 每 500ms 扫描 16 个通道的 RMS 值，DC（或峰峰值） 

  包含瞬态时可选择峰峰值 

振动总量扫描：   

直流量扫描速率 

和振动总量同步扫描（包括直流间隙电压、温度计加速度计偏置

电压） 

振动总量及直流量精度 1KHz 时为输入通道量程的 1% 

振动总量及直流量分辨

率 16 位 

基于事件的数据采集 继电器输入，转速，直流量，交流量或者软件控制 

稳态（生产状态）监测   

数据采集间隔 基于事件和/或基于事件 

数据存储间隔 基于事件和/或基于事件 

交流量、直流量分辨率 24 位，每 2 个通道同步 

动态范围 100db，所有范围 

频谱分辨率 100 至 6400 线 

最大分析频率 Fmax 频谱扫描速率 10Hz-40kHz 

频率扫描周期 每秒两通道，400 线，400Hz，一次平均。（根据分析组态） 

幅值精度 5%0.2Hz-0.5Hz，2%0.5Hz-25kHz，4%25kHz-40kHz 

频率精度 0.01%，根据晶振 

THD 总谐波失真 >-90db，所有范围 
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1X 相位精度 1Hz-1kHz 时为 4 度（低于 1Hz 无标定），>1kHz 时为 5 度 

分析和趋势分析参数 总能量，某频率范围内总能量，非同步能和同步能量， 

  同步峰值，同步相位，真实峰值，HFD 高频检波，波形峰峰值 

  转速 RPM，间隙电压，轴心轨迹，用户可自定义参数名 

分析设置 每个设备和测点都可使用多种分析类型 

平均方式 普通，PeakVue，阶次跟踪，同步时间平均 

单位 英制，公制，Hz，CPM（次/分），阶次 

坐标 线性，对数，dB 

窗函数 汉宁窗，矩形窗 

 

1.1.3 A6560-T 瞬态处理器卡 

A6560-T 包含 A6560 的所有功能，并且包含瞬态选项。当实时振动总量监

测为所有旋转设备提供一个快速检测时，预测性设备状态中央处理器实行

两通道一次的帮助诊断设备状态恶化情况的高级分析。时域波形、频谱和

分析参数从现场计算得出。基于事件的自适应性监测为你的设备和变化的

过程状态提供完全合适的监测模式。通过现场的自调整，结果从现场传送

到控制系统或 AMS Suite：用来分析和存储的设备状态管理软件。 

瞬态处理器监测对所有 24 通道实时监测和同步记录连续时域波形。所有

通道超过 100 小时的连续时域波形被同步缓存，能够被永久保存，自动或

手动提取，实时观察或回放。 

A6560-T 具备以下功能： 

 A6560-T 具备 A6560 所有功能 

 所有通道大于 100 小时同步非快照连续波形数据采集缓存 

 手动或自动永久保存缓存数据 

 实时同步观察 11 项分析图谱 

 重播保存数据就像设备正在运行时一样 

 外部网络选项保存（NAS 驱动）支持缓存数据 

 后面板最多 48 通道同步数据采集 

缓存 所有通道不间断，大于 100 小时连续时域波形记录。用户通过选择时

间段决定选择波形部分，或者快速扫描数据查找异常部分进行提取。 



CSI 6500 预测分析系统 

操作手册 

V0.1 2015.11.3 

 

 

 
Emerson Process Management – Confidential and Proprietary 

 

保存 用户能够从缓冲器中提取时域波形数据，或者通过设置触发条件自动

存档某一事件前后 1 小时数据。如振动增大，设备转速改变，一个输

入或输出触发继电器能够处理将自动存档数据永久保存到网络硬盘。 

实时观察 瞬态处理器能够让用户从现场监测直接连接到 AMS 设备管理并且实

时查看 11 中图谱——轴心轨迹，轴心位置，瀑布图，级联图，波德

图，奈奎斯特图，波形图，频谱图，振动总量，DC 值和速度等。在

界面用户可以对轴心轨迹进行滤波，改变分辨率，选择一个通道或全

体设备来观察。 

重播 如果你错过了时间的实时模式，重播部分能够被使用。回放就是在监

测系统中演示已被存储的数据。也就是同样的 11 中图谱能够像实时

观察模式一样的方式进行显示。 

 

A6560-T 规格说明（包含 A6560 所有规格说明加上以下部分） 

通道数 支持 2 块 A6510-T 模块 

存储容量 64Mb SDRAM，16Mb 闪存 

交流通道精度 5%0.2Hz-0.5Hz，2%0.5Hz-2kHz 

频率范围 DC 到 40kHz 稳态监测 

  DC 到 2kHz 瞬态监测 

  峰峰值校正可组态 

交流/直流分辨率 16 位 

频谱分辨率 200-6400 线 

动态范围 >80dB 

转速计通道数量 4 个 

数据储存量 100+小时，1Gb/小时/24 通道 

通讯 10/100baseT 以太网 HUB 和 NIC 

  推荐瞬态使用 100BaseT 

 

1.1.4 A6510/A6510-T 信号输入模块 

信号输入模块连接着现场传感器和机械状态处理器。 

每块信号输入模块 A6510/A6510-T 能够最多输入 12 通道振动信号，2 通道

转速计信号和 3 通道继电器输入/输出。输入继电器可用于基于事件的振

动监测模式的外部控制，输出继电器可用于报警提醒。最多两块

A6510/A6510-T 信号输入模块能够和 A6560/A6560-T 处理器组合使用。 
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一般参数   

传感器输入类型 动态位移探头，加速度计，速度探头，自定义交流量（磁通、动态压 

  

力传感器、动态基重等），自定义直流量（温度或其他过程参数），

4-20mA 信号。 

传感器通道数 

每块卡 16 个输入通道（12 通道传感器 输入，2 通道转速计和 2 通道

数字 I/O 输入）， 

  每个 A6560 框架可包括 2 块信号输入卡，通过以太网联接 

分析带宽 直流量~40kHz，瞬态为直流~2kHz 

交流转折频率 <0.5Hz 

RMS 通道精度 30Hz 到 40KHz 时为满量程的 1%，20Hz 时为满量程的 2.5%，10Hz 

  时为满量程的 5%，低于 10Hz 无标定 

模拟积分 每通道一次积分（加速度到速度或速度到位移） 

模拟积分精度 <2%（频率和幅值） 

AC 输入范围 ±0.5Vpk，±1Vpk，±5Vpk，±10Vpk（可软件组态） 

DC 输入范围 ±24Vdc 

AC+DC 最大输入范

围 ±24V 

传感器供电型式 ICP 加速度计速度传感器由每个传感器通道供电 

  位移传感器由安装保险丝的-24V 直流电源供电 

触感器通道电源 每个通道 22V，4mA（额定）的恒定电流 

带电源通道输入阻

抗 500KΩ（单端） 

不带电源通道输入

阻抗 1MΩ（差分） 

不带电源传感器类

型 位移，交流或直流过程量 

Mux 卡模拟输出 ChX，ChY，RMS，直流量/过程参数，峰峰值(瞬态） 

转速计通道规格说

明   

转速计通道数 每块 A6510 模块 2 通道 

测量范围 0.1Hz 到 2kHz(6RPM 到 120,000RPM） 

转速计精度 0.10% 

转速计分辨率 0.002Hz@60Hz（0.1RPM） 

转速计类型 电涡流位移传感器，TTL，磁力转速计 

转速计 输入及触发脉冲范围±0.5V 到±24V，±25V CM 

脉冲特性 每旋转一周产生一个脉冲，500us/分钟 

  脉冲宽度，转速计驱动在卡件上。 

模式 电压比较，自适应，转速齿轮模式（除 N 模式） 
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输入阻抗 1MΩ（差分） 

继电器通道规格说

明   

通道数 每块 A6510 模块 2 通道输入或输出 

  无需预订输入/输出继电器类型。可通过开关进行设置。 

  无锁定，继电器自动复位 

  继电器设计成精准，通告和基于事件检测。 

  A6470 继电器卡件为设备自动调停回路所设计 

输入阻抗 1MΩ（差分） 

输入阻抗 输入阻抗 

响应时间 50us~50ms 

数字量输入高电压

/电流 5VDC-24VDC/10mA 24VDC 

数字量输入低电压 <3VDC 

 

1.2 CSI6500 前面板 

CSI 6500 预测分析部分（TDM）包括两种卡件：CSI 6560 处理器卡和 CSI 

6510 信号输入卡。上电以后，6560 处理器卡和 CSI 6510 信号输入卡的

LED 灯将会指示 TDM 的状态 

1.2.1 A6560 处理器卡 LED 

处理器卡共有 7 个双色 LED。从上至下依次是：Input Power/输入电源，

CPU Status/CPU 状态，Transient Status/瞬态状态，System Status/系统状态，

Server Connect/服务器连接，Modbus Connect/硬件连接以及 HD Active/硬

盘激活。 
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 Input Power/输入电源 

输入电源 LED 反应处理器卡内部提供不同电压的所有电源转换器的状态。

稳定的绿灯代表所有电源转换器输出的电压在正常范围内，而持续或闪烁

的红灯代表 CPU 卡件内部某处电源有故障。 

 CPU Status/CPU 状态 

CPU 状态 LED 反映主处理器板的状态。下面列出了 LED 的 4 种情况及其优

先级，对应了 4 种主处理器板状态。 

注： 

有可能在同一时间存在多种状态。当这种情况发生时，LED 将指示最高优

先级的状态。例如：如果卡件同时处于“Uncalibrated/未标定”(3)和

“Performing POST/上电自检”(1)两种状态下，LED 将指示“Performing 
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POST/上电自检”。同样，如果模块同时处于“Uncalibrated/未标定”(3)和

“Failure/失效”(2)两种状态下，LED 将指示“Failure/失效”。 

LED 颜色  状态 优先级 备注 

闪烁的绿灯 上电自检 1  通常只在系统启动的时候存在该状态。反映系统正

在自检 

稳定的红灯  失效 2  Failures include: Power supply POST failure, or other 
hardware failure on processor board  

故障类型包括：电源自检失败，或处理器板卡上其

他硬件失效 

交替的红/

绿灯  

未标定 3  处理器板卡的测试函数发生器未标定 

稳定的绿灯  正常 4  正常  

 

 Transient Status/瞬态状态 

瞬态状态 LED 反映瞬态子板的状态。如果系统没有安装瞬态板卡，LED 将

一直处于关闭状态。下面列出了 LED 的 4 种情况及其优先级，对应了 4 种

主处理器板状态。注意有可能在同一时间存在多种状态。当这种情况发生

时，LED 将指示最高优先级的状态。 

LED 颜色  状态 优先级 备注 

闪烁的绿灯 上电自检 1  通常只在系统启动的时候存在该状态。反映系统正

在自检 

稳定的红灯  失效 2  Failures include: Power supply POST failure, or other 
hardware failure on processor board  

故障类型包括：电源自检失败，或处理器板卡上其

他硬件失效 

交替的红/

绿灯  

未标定 3  处理器板卡的测试函数发生器未标定 

稳定的绿灯  正常 4  正常  

 

 System Status/系统状态 

系统状态 LED 反映系统的总体状态。它反映了系统所有板卡的最坏状态。

例如，如果主处理器卡内的测试函数发生器未标定，同时第一块信号输入卡有一个
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电源失效，系统状态 LED 就会显示稳定的红灯来反映这两种情况的最坏状态——

“Failure/失效” 

当所有固件按照预期运行后，这个 LED 会以“心跳”脉冲形式显示系统状

态。“心跳”以 4 次脉冲为一个周期。在第一次和第二次之间 LED 会短暂

地熄灭，然后第三次和第四次为持续打开状态。看起来像是人的心跳的感

觉。如果心跳停止，代表固件运行出现错误。大部分时间系统可以自动修

复。但是，如果系统无法快速修复，它将自动重启并修复故障以恢复监测。 

 Server Connect/服务器连接 

服务器连接 LED 反映 MHM 机械健康管理软件或 DHM 诊断软件是否连接

上 CSI 6500。绿灯代表 MHM 机械健康管理软件或 DHM 诊断软件中至少有

一个以客户端模式连接上。红灯代表 DHM 软件以 Single User 模式连接上

CSI 6500。在这种状态下，其他客户端无法连接。如果 LED 为熄灭状态，

代表没有任何客户端软件连接上。客户端数据传输时 LED 没有指示，只有

在至少有一个稳定的连接时 LED 会亮。 

 Modbus Connect/Modbus 连接 

Modbus 连接 LED 反映是否有 Modbus 客户端、网页浏览器或瞬态实时客

户端连接。绿灯代表至少有一种客户端有稳定的连接。如果 LED 灯熄灭就

代表没有任何客户端连接。客户端数据传输时 LED 没有指示，只有在至少

有一个稳定的连接时 LED 会亮。这个 LED 灯没有使用红色。 

 HD Active/硬盘激活 

硬盘激活 LED 反映瞬态板卡上的瞬态硬盘是否处于读/写状态。每次瞬态

硬盘有读/写操作时绿灯会闪烁。LED 显示绿色时间越长，硬盘读/写操作

越多。如果系统部包括瞬态板卡，LED 灯将一直处在熄灭状态。 

1.2.2 A 6510 信号输入卡 LED 

每一个 CSI 6510 信号输入卡有两个双色 LED，上面的 LED 指示 CSI 6510 电

源转换器的状态，下面的 LED 指示 CSI 6510 卡的总体状态。 
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 Power LED/电源 LED 

电源 LED 反映信号输入卡的电源转换器的状态。所有电压在正常水平时显

示稳定的绿灯，CSI 6510 卡内部某处电源出现故障时显示稳定或闪烁的红

灯。 

 Status LED/状态 LED 

状态 LED 反映 CSI 6510 卡的总体状态。下面列出了 LED 的 4 种情况及其优

先级，对应了 4 种 CSI 6510 卡的状态。 

注意： 
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有可能在同一时间存在多种状态。当这种情况发生时，LED 将指示最高优

先级的状态。 

LED 颜色  状态 优先级 备注 

闪烁的绿灯 上电自检 1  通常只在系统启动的时候存在该状态。反映系统正

在自检 

稳定的红灯  失效 2  Failures include: Power supply POST failure, or other 
hardware failure on processor board  

故障类型包括：电源自检失败，或处理器板卡上其

他硬件失效 

交替的红/

绿灯  

未标定 3  一个或多个通道未标定 

稳定的绿灯  正常 4  正常  

 

1.3 CSI 6500 背板及接线 

CSI6500 背板功能： 

 连接传感器输入 

 转速计输入 

 开关量输入/输出 

 拨码开关：信号是否来自于 CSI6000 系统 

 拨码开关：加速度传感器是否供电 

 SMB 端子：用于标定测试信号输出 

 +24VDC 供电 

 系统故障继电器输出 

 HUB/NIC 网络接口 
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（1） 传感器输入接线端子 MSIG1（Ch1-12）和 MSIG2（Ch13-24） 

（2） 转速计输入接线端子 MSIG1（Ch1-2）和 MSIG2（Ch3-4） 

（3） 继电器 I/O 接线端子 MSIG1（Ch1-2）和 MSIG2（Ch3-4） 

（4） 拨码开关：信号是否来自于 CSI6000 系统 

（5） 拨码开关：加速度传感器是否供电 

（6） SMB 端子：用于标定测试信号输出 

（7） -24VDC 接线端子，为电涡流传感器供电 

（8） 系统故障继电器接线端子 

（9） 框架供电+24VDC 接线端子 

（10） HUB 网络接口 

（11） NIC 网络接口 

（12） 接地接线柱 

（13） 供电 LED 灯 

（14） +24V 输入 LED 灯 

（15） 系统状态 LED 灯 



CSI 6500 预测分析系统 

操作手册 

V0.1 2015.11.3 

 

 

 
Emerson Process Management – Confidential and Proprietary 

 

1.3.1 信号输入端子 

每个信号输入通道有 5 个端子，前两个 SIG+和 SIG-用于信号输入。如果为

加速度传感器供电的拨码开关打到“ON”上，这两个端子也能为传感器

提供+24V 的恒流源。 

接下来两个端子为 Power-和 Power+，当 J19 端子接入-24VDC 时，这两个

端子可以作为-24VDC 供电。 

最后一个端子作为传感器屏蔽层接线端子。 

MSIG1 

J1 J2 J3 J4 

SIG+1/+24 SIG+5/+24 SIG+9/+24 Tach+1 

SIG-1/+24 Return SIG-5/+24 Return SIG-9/+24 Return Tach-1 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+2/+24 SIG+6/+24 SIG+10/+24 Tach+2 

SIG-2/+24 Return SIG-6/+24 Return SIG-10/+24 Return Tach-2 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+3/+24 SIG+7/+24 SIG+11/+24 I/O+1 

SIG-3/+24 Return SIG-7/+24 Return SIG-11/+24 Return I/O-1 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+4/+24 SIG+8/+24 SIG+12/+24 I/O+2 

SIG-4/+24 Return SIG-8/+24 Return SIG-12/+24 Return I/O-2 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

 

MSIG2 

J5 J6 J7 J8 

SIG+13/+24 SIG+17/+24 SIG+21/+24 Tach+3 
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SIG-13/+24 Return SIG-17/+24 Return SIG-21/+24 Return Tach-3 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+14/+24 SIG+18/+24 SIG+22/+24 Tach+4 

SIG-14/+24 Return SIG-18/+24 Return SIG-22/+24 Return Tach-4 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+15/+24 SIG+19/+24 SIG+23/+24 I/O+3 

SIG-15/+24 Return SIG-19/+24 Return SIG-23/+24 Return I/O-3 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

SIG+16/+24 SIG+20/+24 SIG+24/+24 I/O+4 

SIG-16/+24 Return SIG-20/+24 Return SIG-24/+24 Return I/O-4 

-24 -24 -24 -24 

GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） GND(-24 V Return） 

Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) Chassis GND (Shield) 

注：I/O 通道的-24V 不能用于 I/O 接线。 

1.3.2 +24VDC 供电要求 

输入电压 18VDC-31VDC（名义上 24VDC） 

输入电流（带瞬态模块） 
1.0ADC@24VDC（不对传感器供电） 

1.25ADC@24VDC（对所有传感器供电） 

输入电流（不带瞬态模块） 
0.65ADC@24VDC（不对传感器供电） 

0.9ADC@24VDC（对所有传感器供电） 

最大浪涌电流 
1ms：7ADC@24VDC  

20ms：3ADC@24VDC 

最大功率消耗 22W（30W 带瞬态模块） 

mailto:7ADC@24VDC
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注：不能使用同一个 24VDC 电源供+24VDC 和-24VDC 

 

注：供电和接地线缆规格最小为 14AWG。 
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1.3.3 系统故障继电器 

系统故障继电器可以接常开（C 和 NO），也可以接常闭（C 和 NC）。 

1.3.4 CSI6500 接 4-20mA 信号 

当 CSI6500 系统接 4-20mA 信号作为输入时，需要在 SIG+和 SIG-之间接入

250Ω电阻，这样可以把电流信号转化为电压信号。 

 

1.3.5 网络接口 

CSI6500 背板上 HUB 和 NIC 网络接口功能与前面板 HUB 和 NIC 网络接口能

能一致。 

常用的网络结构如下图所示。 
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以上内容来自手册光盘 CSI_6500_Install 

2 CSI 6500 系统 

2.1 CSI6500 系统结构及组成部分 

CSI6500 系统结构及组成部分如下： 

 现场安装的传感器 

 CSI6500 框架 

 A6560 处理器卡 

 A6510 信号输入模块 

 服务器 

 CSI6500 固件（装载在在线服务器上，可以下载到 CSI6500） 

 MHM 在线软件 

 在线数据库 

 以太网网线 

2.2 与 CSI6500 相关的 Windows 服务 

1) 右键点击“我的电脑”，选择“管理” 
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2) 展开左边树状结构中“服务和应用” 

3) 在左边的树状结构中选择“服务” 

 

CSI6500 系统用到的服务包括：CSI_MhmRemote，CsiMtdbMgr，

CsiNetAdmin，CsiO_server，和 FTP Publishing。当电脑当做服务器主机安装

在线软件时，这些服务会自动安装。当电脑启动时这些服务也会自动启动。

因此，它们的状态应当一直为“启动”状态。 

2.3 网络组态 

每套 CSI6500 系统都有一个唯一的 IP 地址用于和服务器进行通讯。该 IP

地址在艾默生工厂进行 FAT 或在客户现场进行 SAT 时会被设置好。如果客

户想要更改 CSI6500 框架 IP 地址，请联系当地客户服务代表。 
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3 AMS Suite: Machinery Health Manager 

3.1 AMS Machinery Manager 介绍 

AMS Machinery Manager 是拥有多种技术进行数据分析的软件包，其被设

计用来进行机械健康管理。AMS Machinery Manager 支持 CSI 机械健康分

析仪，在线状态监测系统，油液分析和其它机械健康数据采集设备。 

AMS Machinery Manager 软件程序兼容 32 位和 64 位操作系统。 

AMS Machinery Manager 特点和功能包括： 

 支持 CSI2130，CSI2140，CSI2600 和 CSI6500 等产品。 

 通过有效的客户端-服务器架构，支持共享访问多个 AMS Machinery 

Manager 数据库。 

 集成振动分析、油液分析、红外热成像、超声检测、动平衡和电机诊

断等多种技术。 

 自动进行数据库设置功能 

 提供交互式报表功能 

如果你不熟悉电脑及其外设，或者微软操作系统，艾默生公司强烈推荐你

在使用 AMS Machinery Manager 软件前阅读操作手册。 

3.2 安装指导 

3.2.1 单机版安装 

1) 退出所有应用程序并把 AMS Machinery Manager 光盘插入电脑光驱。 

2) 在“我的电脑”中，右键打开 AMS Machinery Manager 光盘。 

3) 右键点击“RBMsetup.exe”，然后选择“以管理员身份运行”。出现

开始安装画面。 

注：系统可能会提示你安装 Microsoft .NET Framework 4.0。如果没有出现

该提示，可能你的系统已经安装了 Microsoft .NET Framework 4.0。在

Microsoft .NET Framework 4.0 安装完毕后，会出现重启电脑的提示，请重

新启动电脑，然后重新点击“RBMsetup.exe”进行安装。 
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4) 软件许可证协议出现。如果你同意这些信息，请点击“I accept the 

license terms”，然后点击下一步。 

5) 关于数据库版本的警告出现。如果你是第一次安装软件，选择“是”

然后继续。如果是升级安装，请仔细阅读该信息，然后选择“是”继

续，或者选择“否”忽略安装。 

注：如果你没有备份数据库，请选择“否”，然后备份你的数据库。 

6) 选择功能进行安装界面出现。 

7) 选择 Single-User 进行安装。 

 

注：建议使用默认安装目录。 

8) 点击开始安装，安装画面会显示安装的状态。 

9) 如果你使用防火墙，你会被提示要求允许艾默生过程管理程序通过防

火墙。请选择允许通过。 

10) 序列号注册对话框出现，请联系艾默生服务人员进行注册。 
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11) 点击“Register Product”，出现下面对话框。请把“Serial No.”和

“Request No.”提供给艾默生服务人员。 

 

12) 艾默生服务人员会帮你申请“Response”码，然后提供给你。输入

“Response”码点击确定回到序列号注册对话框。 

注：如果在安装过程中取消注册，你可以在软件安装完毕后在

C:\RBMNET\RBMsuite\sys 文件夹下双击“Serial.exe”进行注册。 

13) 序列号注册对话框显示“已注册”，点击“关闭”继续安装。 

14) 软件安装完成后，点击“完成”，重启电脑，软件安装完毕。 
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3.2.2 网络版安装 

1) 退出所有应用程序并把 AMS Machinery Manager 光盘插入电脑光驱。 

2) 在“我的电脑”中，右键打开 AMS Machinery Manager 光盘。 

3) 右键点击“RBMsetup.exe”，然后选择“以管理员身份运行”。出现

开始安装画面。 

注：系统可能会提示你安装 Microsoft .NET Framework 4.0。如果没有出现

该提示，可能你的系统已经安装了 Microsoft .NET Framework 4.0。在

Microsoft .NET Framework 4.0 安装完毕后，会出现重启电脑的提示，请重

新启动电脑，然后重新点击“RBMsetup.exe”进行安装。 

4) 软件许可证协议出现。如果你同意这些信息，请点击“I accept the 

license terms”，然后点击下一步。 

5) 关于数据库版本的警告出现。如果你是第一次安装软件，选择“是”

然后继续。如果是升级安装，请仔细阅读该信息，然后选择“是”继

续，或者选择“否”忽略安装。 

注：如果你没有备份数据库，请选择“否”，然后备份你的数据库。 

6) 选择功能进行安装界面出现。 

7) 选择所有功能进行安装。 

 

注：建议使用默认安装目录。 
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8) 在“Destination Location”标签，你可以点击“浏览”指定不同的默认

目标文件夹进行软件安装。 

9) 对于新的安装，默认的数据存储位置可以进行更改。对于软件升级，

这些对话框是灰色的，不能进行更改。 

 

10) 点击开始安装，安装画面会显示安装的状态。 

11) 序列号注册对话框出现，请联系艾默生服务人员进行注册。 

 

12) 点击“Register Product”，出现下面对话框。请把“Serial No.”和

“Request No.”提供给艾默生服务人员。 
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13) 艾默生服务人员会帮你申请“Response”码，然后提供给你。输入

“Response”码点击确定回到序列号注册对话框。 

注：如果在安装过程中取消注册，你可以在软件安装完毕后在

C:\RBMNET\RBMsuite\sys 文件夹下双击“Serial.exe”进行注册。 

14) 序列号注册对话框显示“已注册”，点击“关闭”继续安装。 

15) 软件安装完成后，点击“完成”，重启电脑，软件安装完毕。 

3.2.3 CSI 6500 固件安装 

3.2.4 聊天工具安装 

3.3 在线系统组态 Online Configuration 

3.3.1 与 CSI 6500 建立通讯 

点击桌面上的 AMS Machinery Manager Client，进入 AMS Suite: Machinery 

Health Manager 机械健康管理平台（以下简称 MHM 软件） 

 

输入用户名和密码，默认账号 Administrator，密码为空 
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选择 Tools->Setup/Communication 中的 RBM Network Administration 程序，

双击打开 

 

弹出 RBM Network Administration 程序 
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在下方的 Online Servers 中双击，弹出 Add Online Server 对话框，输入服

务器的 IP 地址或计算机名 

 

双击建好的 Online Server “192.168.0.1”，弹出下面的对话框 
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点击 Active Units 右边的 Edit 按钮，弹出下面的对话框 

 

在 New Unit 下方输入需要连接的 CSI 6500 的 IP 地址，然后点击 Add New

按钮，重复这个操作加入所有需要连接的 CSI 6500 的 IP 地址 

 

完成后点击 Ok 按钮 
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点击 Done 按钮，关闭 RBM Network Administration 

 

双击打开 Online Configuration 程序 
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打开菜单 File->Online Server->Open，输入服务器的 IP 地址或计算机名，

也从下拉框中找到服务器的计算机名，连接在线服务器 

 

连接上服务器后，如果软件检测到 CSI 6500 已经与服务器建立连接，在

Available Units 文件夹下就会显示该 6500 框架的物理地址 
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右键点击框架，选择 Insert，将该框架导入 

 

所有框架导入后，第一部分与 CSI 6500 建立连接就结束了，接下来要完善

数据库。  
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3.3.2 6500 组态 

将导入的 6500 框架更改其简称（Abbreviation）和描述（Description） 

 

右键点击框架，选择 Configure Unit，可以对框架进行组态 

 

右边出现 6500 的虚拟面板。每个 6500 包括一个 CPU 卡和 1~2 个信号输

入卡。信号输入卡上面 12 个通道为信号输入通道，接下来的 2 个通道为
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转速输入通道，最后 2 个通道为继电输入/输出通道。右键点击信号输入

通道，选择 Define，定义单个信号输入通道 

 

弹出通道定义对话框，输入通道描述，选择信号类型（动态信号选择

Vibration，过程量选择 Process），点击 Properties 按钮进行详细组态 

 

选择传感器类型，轴振选 Displacement Probe，瓦振选 Velometer 或

Accelerometer（根据所用传感器类型） 
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选择新建传感器 

 

根据传感器相关资料，输入传感器描述、灵敏度、AC 及 DC 范围后，点击

OK 按钮 
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可以根据需要测量的范围调节增益（gain），输入静止时候的直流电压

Resting DC Voltage 和轴承间隙 Bearing Clearance 
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如果通道配置相同，可以利用 Copy（复制）和 Paste（粘贴）配置其他通

道 

 

粘贴完后更改通道名称即可  
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接下来组态瓦振通道 

 

同样，新建一个瓦振传感器 

 

输入传感器名称、灵敏度、AC 和 DC 范围 
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调整通道增益，使得 AC 测量范围与所需的测量范围接近 
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复制、粘贴，配置其他瓦振通道 

 

对每个通道进行测试。右键点击通道，选择 Commission 
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会弹出数据采集对话框，可采用默认配置采集一次数据，检查数据是否正

常 

 

点击 Acquire 按钮后会得到此刻该通道测得的时域波形和频谱数据（有时

候需要等待一定时间才能得到数据） 
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点击 Commisson 后该通道就会由红色变为打钩的绿色，代表该通道已经调

试完成，可以使用 
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依次对所有通道进行 Commission 

 

如果两块卡的信号通道相似，也可以复制一块卡，粘贴到另外一个框架上

面 
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更改所有通道的名称 

 

对所有通道进行 Commission 
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接下来定义转速通道 
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定义转速通道的描述、触发（通常选为自动触发）。如果测量的是转速齿

轮，则需要在 Software Factor 下面的框中输入齿数的倒数（以小数形式） 

 

对转速通道进行 Commission 
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CSI 6500 采集数据的形式有两种：基于时间或基于触发条件（包括转速、

通频值、DC 值、继电器、其他触发条件及它们之间的逻辑组合）。如果

希望设置为基于触发条件的采集模式，右键点击框架下面的 Predicates 文

件夹，选择 Add Collection Predicate 

 

输入触发条件的名称，设置该触发条件。下面的例子为设置一个转速大于

或等于 100 转的触发条件 
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所有 6500 框架组态完毕。接下来设置分析参数（Analysis Parameter）和

报警界限（Alarm Limit）。右键点击 Analysis Parameter Sets 文件夹，选择

Add AP Set 

3.3.3 设置分析参数和报警界限 

 

设置分析参数的描述。在 Data Acquisition 标签下，设置传感器类型、采集

模式（Normal/PeakVue，PeakVue 只有在传感器为加速度计时可以选择）、

频率单位类型（阶次或 Hz）、最大分析频宽、线数、窗函数、平均模式、

平均次数等。 
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在 Parameters 标签下设置分析参数。分析包括总能量、某频率范围内总能

量、非同步能量和同步能量、同步峰值、同步相位、真实峰值、HFD 高频

检波、波形峰峰值、同步峰值、同步相位、时域波形变化率、峭度因子等 
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根据实际需求设置相应的分析参数。下面给出的例子是一组典型的分析参

数 
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右键点击建好的分析参数组，选择 Add Alarm Limit，即可针对该分析参数

组新增报警界限，一个分析参数组可以建立多个报警界限。 

选择到需要修改包警界限的分析参数，在下方点击右键即可对报警界限进

行修改 
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分析参数和报警界限都可以利用 Copy 和 Paste，节省组态时间 

 

同一类型的设备可以用同一个分析参数组，不同类型的设备最好用不同的

分析参数组 
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3.3.4 区域、设备、测点建立 

分析参数和报警界限建立完毕后，开始设置区域、设备、测点等信息。 

右键点击 Areas 文件夹，选择 Add Area 

 

给区域设置编号和描述 



CSI 6500 预测分析系统 

操作手册 

V0.1 2015.11.3 

 

 

 
Emerson Process Management – Confidential and Proprietary 

 

 

右键点击区域，选择 Add Equipment 
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设置设备的简称、描述和转速 

 

点击 Browse 按钮，设置设备显示的转速。该汽轮机的转速为 6500T01 上

的转速通道，因此选择 6500T01 
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选择 Physical（实际转速通道），选中 Channel 1 – Tach，点击 OK 按钮 
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右键点击设备，选择增加 Add Component，增加设备组件（一台设备可能

由几个大的组件组成，如一台泵可能由电机、齿轮箱和泵组成，每个组件

必须在一个框架内监测 
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设置组件的简称、描述、设备类型、物理特性、转速 
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右键点击组件，选择 Add Measuremnt Pt，增加测点 
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设置测点相关信息 
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再增加一个测点。注意该测点由于与前一个测点是同一个位置的 XY 方向，

如果需要显示轴心轨迹，需要将它和之前那个测点设置为关联测点。 
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所有测点都加上 
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选中组件，在点击右边窗口的 Monitoring Unit 标签，将设备的测点和

6500 框架及通道关联起来 
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点击 Attach 按钮，选择用来监测的框架 

 

再选择转速通道 
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对第二个组件采用类似的方法 
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右键单击测点，选择 Add DCS，增加数据采集设置。这里的 DCS 将主要设

置采样参数、采样方式、分析参数、报警界限、数据存储方式等。 
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选择分析参数（之前已经建好） 
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选择报警界限 

 

在 Data Reporting 标签中设置数据存储间隔。分两类数据：分析参数（AP）

和波形频谱（Block Data）。波形频谱最多一个 DCS 存储 250 组，采用滚
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动存储方式，而分析参数则一直保存下去，不会覆盖以前的数据。但整个

数据库文件有 2G 的限制，因此，当数据库达到 2G 时，数据将不再保存。

这时候可以考虑更换新的数据库。 

 

在 Collection Scheduling 标签下选择采集方式，这里选择基于触发条件的采

集，当转速大于或等于 100RPM 时进行采集，触发条件之前已经建好。 
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DCS 也可以利用 Copy 和 Paste 进行复制粘贴 
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所有测点均设置好 DCS。这里每个测点设置了两个 DCS。这两个 DCS 的分

析参数和报警界限一样，但存储数据的方式不一样。Short Term Data 

Collection 存储短期的数据，间隔较短，目前设置的是 10m（10 分钟）存

储一组分析参数，1h（1 小时）存储一组波形频谱；Long Term Data 

Collection 存储长期的数据，间隔较长，目前设置的是 1h（1 小时）存储

一组分析参数，1d（1 天）存储一组波形频谱 
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不同的传感器需要选择不同的分析参数和报警界限 
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一台设备可以集中一起修改数据存储时间间隔，方法是右键点击设备，选

择 Edit->DCS Data Reporting 

 

也可以集中一起设置是否激活 DCS 方法是右键点击设备，选择

Activate/Deactivate DCSs 
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对于没有安装转速计的定转速设备，可以设置一个定转速，方法是右键点

击 6500 框架，选择 Constant Tachometers 
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其他设备按照同样的方法建立组件、测点、数据采集方式 
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DCS 建立好以后，一台设备上的所有 DCS 可以一起设置是否激活，方法是

右键点击设备，选择 Activate/Deactivate DCSs 

 

将需要激活的 DCS 前方的复选框打钩 
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激活所有设备的 DCS 
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到此为止，稳态部分的组态内容基本完成，如果不需要瞬态分析，或者

6500 为 M 系列，不包括瞬态分析功能，就可以保存数据库了。 

点击菜单 File->Online Server->Save，然后输入数据库名，即可保存数据库。

数据库保存好后 Online Configuration 程序会自动关闭。 
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3.3.5 瞬态分析组态 

对于 6500T 系列，可以进行瞬态分析。要进行瞬态分析的通道通常需要有

转速通道与之关联，即在建立组件、测点时，必须每一个测点有一个物理

转速计与之关联，如下图。 

 

右键点击 Units 文件夹下的 6500 框架，选择 Commission Transient 

Channels 



CSI 6500 预测分析系统 

操作手册 

V0.1 2015.11.3 

 

 

 
Emerson Process Management – Confidential and Proprietary 

 

 

系统会弹出 Commission Transient Channels 对话框。在 Transient Tachmetor

下方的下拉框中选择需要组态的转速通道，如果已连接转速计，右方的

RPM 中会显示实际转速。如果此时还测不到转速，可以将 Read Current 

RPM 左边的复选框中的钩去掉，手动输入一个转速。在对话框下方，系统
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会根据之前的组态显示与该转速通道关联的信号通道。选择需要设置为瞬

态的信号通道，点击 Acquire 按钮 

 

系统会同步采集所有选择通道的信号。点击 Commission 按钮 
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刚才选择的信号通道即被组态为瞬态通道。注意通道上的绿灯已由之前的

变为  
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其他框架采用同样的方法 
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瞬态分析的组态也已经结束。这时候可以保存数据库了。点击菜单 File-

>Online Server->Save，然后输入数据库名，即可保存数据库。数据库保存

好后 Online Configuration 程序会自动关闭。 
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3.4 在线系统实时监测 Online Watch 

1) 双击桌面上的图标 ，进入 AMS Suite: Machinery Health 

Management 操作平台。 

2) 输入登陆密码，默认为空 

 

3) 进入软件后，点击“Tool”，并选择左侧的 Analysis，画面如下图所示 
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4) 双击 图标，进入实时在线监测软件。 

5) 进入 Online Watch 后的主画面如下图所示： 

 

Online Watch 主窗口由标题栏，菜单栏，工具栏，用户主界面和状态栏组

成。用户主界面分为两个面板。左面板是数据库的树状结构，右边面板是

主要的监测界面，它的内容由树状结构中被选择的项目决定。 

展开左边树状目录下的 Areas 文件夹得到下面的画面。如果设备出现报警

情况，则树状目录下会出现红色或黄色的报警标记。点击到相应的测点上，

还可以看到分项报警情况，反映该测点因什么情况报警。 

CSI6500 数据库目前给加速度传感器测点配置 2 种采集方式：普通数据采

集和 PeakVue 数据采集。前者监测设备的总体振动情况，后者主要监测

滚动轴承的健康状况。这两种采集方式都设置了基于事件的采集方式，即

当测得设备测点的振动总量>0.1g 时，判断设备为运行状态，启动数据采

集，Predicate 栏显示为 True（下图红色圆圈中显示），当振动总量

<0.1g 时，判断设备为停止状态，停止数据采集，但振动总量仍然在时刻

监测（500ms 扫描所有通道）。 
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3.5 振动分析 Vibration Analysis 

3.5.1 振动分析概述 

振动分析功能为周期性振动、在线振动和瞬态分析提供强大的分析能力。

振动分析支持以下图谱： 

 频谱图 

 波形图 

 趋势图 

 瞬态波形 

 级联图 

 峰值/相位 

判断设备是否在

运行状态 
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 轴心轨迹 

 轴心位置 

 参数柱状图 

 相关性 

 互功率谱 

 交叉相位 

 传递函数 

 全频谱 

 全频谱级联图 

 复合趋势图 

3.5.2 振动分析用户界面 

 

A. 树状导航 

B. 选项标签 

C. 图谱显示区 

D. 显示注释 

E. 案例历史 

F. 功能键 
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G. 常用功能 

H. 切换视图 

I. 切换图谱类型 

J. 趋势图 

K. 频谱图 

L. 波形图 

M. 图谱详细信息 

N. 双击在新窗口打开图谱 

O. 测点详细信息 

3.5.3 树状结构导航器 
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分析参数的趋势图如下图所示： 

 

频谱图和时域波形图还可以通过按住 Ctrl 键选择多个图谱进行对比分析 

 

3.5.4 常用功能按钮 

按钮  功能  描述 
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按钮  功能  描述 

 
Setup Options  选项设置 

 
Vertical Scale  放大，缩小纵坐标 

 
Horizontal Scale  放大、缩小横坐标 

 
Horizontal Pan  水平移动 

 
Annotate Plot  标注图谱 

 
Clear Plot  清除图谱 

 
New Window  新窗口 

 
Print/Print Options  打印，以及打印选项 

 
Print Preview  打印预览 

 
Save Image  保存图像 

 
Launch Nspectr  运行 Nspectr  

 
Launch RBMview  运行 RBMview  

 
Show Notes  显示设备注释 

 
Hot Keys  热键 

3.5.5 切换视图按钮 

按钮  功能 描述 

 
Machine Jump  切换设备  

 
Point Jump  切换测点 
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按钮  功能 描述 

 
Prev/Next Data  前一个、后一个，第一个和最后一个图谱 

3.5.6 切换图谱类型按钮 

按钮  功能 描述 

 

Single Spectrum Jump  显示单一频谱 

 

Multiple Spectrum Jump  显示多个频谱 

 

Multiple Point Spectrum Jump  显示多测点频谱  

 

Single Waveform Jump  显示单一波形 

 

Multiple Waveform Jump  显示多个波形 

 

Multiple Point Waveform Jump  显示多个测点波形 

 

Single Trend Jump  显示单一趋势 

 

Multiple Trend Jump  显示多个趋势 

 

Multiple Point Trend Jump  显示多个测点趋势 

 

Parameter Profile Jump  显示参数柱状图 

3.5.7 图谱中点击鼠标右键的选项 

• 在趋势图的横坐标时间上点右键，选择 Setup Options 可以出现下图（下

页）。 

• fixed scale enabled 可以决定横坐标的时间段，是选定时间段还是所有时间

段。 
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• 点击任意频谱图，在横坐标频率位置点右键会出现下图。可以改变横坐标的

单位为频率 Hz，CPM（每分钟多少周期），和 Order（倍频）。 
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• 在频谱图上点右键出现下图 

 

• Copy，拷贝该频谱图，包括光标的信息，测点信息等，可以到任意文档或

画图板中进行粘帖和编辑。 

• New Window，在线窗口中打开该图谱 

• Print Preview 和 Print 为打印预览和打印 

• Save Image 为保存图片到 C 盘 TEMP 文件夹，图片格式为 bmp 
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• Annotate Plot 为图谱加注释。 

• Clear Plot 为清楚图谱上的注释和光标信息等。 

• Display Associated Waveform 为显示该频谱图对应的波形图。 

• Cursor type 为光标类型，包括三种，Single 为单一光标，Harmonic 为谐波，

sideband 为边带。 

• Label Peak 为标记光标点的频率成分，分为 2 中 Primary Cursor 为标记主

光标，All Cursor 为标记所有光标，如果光标类型选择 Harmonic，所有谐

波的频率成分都会标记。 

3.6 瞬态分析 

3.6.1 瞬态实时数据分析 

• 选定机组，点击右键，选择 start live mode，进入实时数据显示模式。 

 

• 通过 Ctrl 选择一个轴瓦上一对测点。 
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• 如果选择单一测点，则无轴心轨迹图，轴心位置图，全频谱图。 
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• 在 live data session 上点击右键，选择 stop live mode，停止实时数据查看。 

 

3.6.2 瞬态历史数据分析 

• 瞬态数据保存，从 100 小时数据中提取想要的数据，例如启停机数据。 

• 右键点击某一设备组建 

• 选择 ‘Start Extraction Session’ 

• 选择 ‘Current Streaming Location’ 

• 弹出选择时间对话框，选择好起始时间，点击 OK。 
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• 出现 Extract-Transient Data Extraction Session，数据提取功能。 

• 6500T-Transient Data Folder，瞬态数据文件夹 

• 数据需要时间读取。例如键相信号，蓝色部分，到 100%后会显示数据。 

 

• 在选定的图谱上选择合适的时间，灰色方框，可以拖动改变时间的长度和位

置。 

• 选定时间段后，点击右键，选择 Extract-Region-of-Interest。会弹出下页画面。 
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• 选择特定的测点进行分析，可以只选择其中任意测点。 

• 设置存档名称，最好以时间作为名称。 

• 点击 Extract，开始导出数据。 

 

• 当进度条完成 100%后，在 Extract-Transient Data Extraction Session 下面会出

现以定义名称瞬态数据库。 

• 右键点击该数据库，选择 save temporary archive，会把选定好时间段内的所

有数据保存进 Archives 文件夹下面。 
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• 成功存储的瞬态数据。 

 

• 右键点击存储的瞬态数据，选择 replay archive。 

 

• 会出现下页所示对话框。 
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• 回放数据的速度  

• 开始、停止和暂停数据回放。  

• 重复回放数据。  

• 选择好后可以最小化该窗口。 

• 瞬态数据查看方式同实时数据查看方式相同。 

3.7 用户权限管理 Network Administration 

来自手册光盘“97402_Rev.21_MHM_Installation & Configuration__v5.51.pdf”

第三章 

3.8 报告 

来自 MHM 的 HELP 文件的“Reporting” 

3.9 故障频率计算 Fault Frequency 

 

来自手册光盘“97399_Rev.13_VibView.pdf” 

3.10 优化 PeakVue 参数设置及报警界限 

3.10.1 滤波器 

当使用 PeakVue 技术时，有限数量的滤波器可以选择。滤波器的选择依赖

于分析带宽 Fmax 以及可能发生潜在故障从而产生应力波的频率范围。 

滤波器种类 

带通滤波器 高通滤波器 

20Hz- 150Hz 500Hz 

50Hz-300Hz 1000Hz 

100Hz-600Hz 2000Hz 
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500Hz-1000Hz 5000Hz 

5000Hz-6500Hz 10000Hz 
20000Hz 

 

3.10.2 PeakVue 参数推荐设置 

转速

（RPM） 

高通滤波

器（Hz） 

推荐 Fmax 传感器磁

铁型式 

推荐平均

次数 

推荐最小

线数 知道轴承

型号 

不知道轴

承型号 

0-700 500 4*BPFI 40*RPM 双磁条 1 800 

701-1500 1000 4*BPFI 40*RPM 双磁条 1 800 

1501-3000 2000 4*BPFI 40*RPM 平面磁铁 1 1600 

3001-4000 2000 4*BPFI 30*RPM 平面磁铁 1 1600 

4001 以上 5000 4*BPFI 40*RPM 平面磁铁 1 1600 

 

注： 

• 上表参数设置经过大量计算、试验和现场测试。可以直接用作数据库

设置。 

• 如果使用 PeakVue 技术测试齿轮，建议至少选择 1600 线；Fmax 一般

设置为 3.25*GMF；如果 3.25*GMF 不超过 2000Hz，高通滤波选择

2000Hz；如果 3.25*GMF 超过 2000Hz，高通滤波选择 5000Hz。 

• Fmax 不能超过高通滤波 

• 大多数情况下，PeakVue 技术使用高通滤波器而不是带通滤波器。这

包括大多数转速在 300-3600RPM 的滚动轴承、齿轮和润滑故障的设备。 

3.10.3 PeakVue 报警值推荐设置 

1) 滚动轴承内圈故障(BPFI)警告(Alert)界限计算公式: 

注： 

• 必须采集至少 10 个转速周期的时域波形 

• 如果是外圈故障(BPFO)，报警界限为上述公式的 2 倍； 

• 如果是滚动体故障(BSF)，报警界限为上述公式的 1.5 倍。 
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• 所有故障类型的故障(Fault)界限为警告界限的 2 倍。 

 

2) 不同转速下轴承与齿轮故障的 PeakVue 报警设置 

转速 RPM 

滚动轴承故障 齿轮故障 

内圈、保持架或 

滚动体故障 
外圈故障 磨损或点蚀 断齿 

0-900 常用转速下报警值*（实际转速/900）
0.75

 

901-4000 

（常用转速） 
3g 6g 3g 6g 

4001-10000 常用转速下报警值*（实际转速/4000）0.5 

10001 以上 5g 10g 5g 10g 

注：所有故障类型的故障(Fault)界限为警告界限的 2 倍。 

来自手册光盘“97399_Rev.13_VibView.pdf” 

3.11 聊天工具 

来自 MHM 的 HELP 文件的“Collaboration Tool” 
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4 常见系统维护及问题解决办法 

4.1 查看 CSI 6500 运行状态 

4.2 更新固件 

4.3 更改启动参数 

4.4 CSI 6500 状态为“Node(Unit)Down” 

4.5 CSI 6500 与在线服务器无法通讯 

（1） 首先检查网络是否连通，直接采用 ping 6500IP 地址的方式，如不通，则检

查 6500 是否正常启动。 

（2） 如果网络连通，检查软件相关服务项是否启动。方法：右键点击我的电脑->

管理->服务和应用程序->服务，所有以 CSI 开头的服务均为相关的服务。 

 
（3） 如果所有服务均正常启动，打开 RBM  Network  Administration，然后双击在

线服务器，检查按钮是否为 Stop Data Collection（表示正在采集）。 
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4.6 在 Online Watch 和 Vibration Analysis 中显示的测量值不正确 

4.7 系统状态指示灯（System Status LED）为红色 

4.8 如何手动备份数据库 

系统数据库默认放在服务器的 RBMnet\RBMSuite\CustData 中，和该项目

有关的数据库文件包括 rbm 格式的数据库文件和同名的文件夹。下面的指

示将带您一步步地备份数据库： 

1) 关掉正在运行的 AMS Suite: Machinery Health Manager 

2) 右键点击我的电脑->管理->服务和应用程序->服务 
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3) 在右边找到 CsiMtdbMgr 服务，点击右键，停止 
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4) 复制数据库文件夹下的 rbm 格式的数据库文件和同名的文件夹到指定

的备份文件夹下，完成备份。 
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5) 重新打开 CsiMtdbMgr 服务（方法同上），打开在线监测软件。 
 

如由于数据库已满而需要重新制作新的数据库，则在备份完成后还需以下

步骤： 

6) 打开 RBM Network Administration 
 

 

 

7) 双击下方的 Online Server，点击 Stop Data Collection 按钮 
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8) 打开 Online Configure 软件，点击 File->Template Database->Open，打开

cvb 模板数据库文件 
 

 

9) 点击 File->Online Server->Open，选择或输入 Online Server 的计算机名，

点击 OK。 
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10) 点击 File->Online Server->Save，输入数据库名，注意不要覆盖原有数据

库 

 

保存后系统将自动关闭 Online Config。 

11) 打开 RBM Network Administration，从菜单栏选择 DB Server->Refresh 

Database List，刷新数据库列表，右边的数据库列表中就会出现新建的

数据库的名称 
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12) 双击下方的 Online Server，检查是否已更新为新数据库以及是否已开始

数据采集。 
 

 

13) 最后打开在线监测画面 
 

 

已更新为

新数据库 

已开始数

据采集 
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4.9 如何自动备份数据库 

以上内容参考手册光盘“97453_Rev.0 CSI 2600.pdf”和中文的 CSI 4500 在

线监测使用手册 

 


